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Chapter 21: Smart Shape Tool

Smart Shape Tool 
What it does
When you click this tool, Finale displays the floating Smart Shape Palette, containing an individ-
ual icon for each of several Smart Shapes—stretchable markings such as slurs, crescendo hair-
pins, 8va brackets, dotted lines, and so on. (If the Smart Shape Palette doesn’t appear, choose its 
name from the Window Menu.) 

To place one of these markings into the score, position the cursor so that the tiny arrow points to 
the appropriate staff. If you’re placing a note-attached marking, the cursor will appear as a tiny 
note; just position the cursor over the note. If you’re placing a notehead-attached marking, the cur-
sor will appear as a tiny notehead. Now double-click—but on the second click, keep the mouse 
button pressed and drag to the right. As you drag, the shape appears and grows to the right. 
Release the mouse when the shape is as long as you want it or highlights the appropriate end note.

Special mouse clicks
• Click the Smart Shape icon on the Main Tool Palette to make handles appear on every 

Smart Shape in the score.

• Click the primary square handle of a Smart Shape in the score to select it; click a Smart 
Shape handle to make diamond editing handles appear. When these editing handles are visi-
ble, you can move, stretch, or reshape the selected Smart Shape.

• Press Ctrl-A to select all Smart Shapes on the page. Drag-select Smart Shape handles to 
select multiple Smart Shapes. Shift-click to add a Smart Shape to the selection.

• Click and drag a diamond editing handle on the tip of the slur to move the slur’s endpoint 
and attach the slur to a different note.

• Click and drag a center curve diamond editing handle to change the slur’s arc height. 
Shift-click and drag the arc handle to change the arc height and the angle of the arc.

• Drag an outer curve diamond editing handle to make asymmetrical changes to the slur’s 
arc and inset. These two handles control the Bezier curve control points.

• Press ctrl and drag an outer curve diamond editing handle for symmetrical changes to the 
slur’s arc and inset.

• Press ctrl, double-click and drag to create an element such as √ below the staff or ◊ 

above the staff.

• Ctrl-click the Custom Line Tool to bring up the Smart Line Style Selection dialog box.

• Hold down S and double-click and drag to create a slur.

• Hold down < and double-click and drag to create a crescendo.
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• Hold down > and double-click and drag to create a decrescendo.

Contextual menus
Contextual menus are reached by right mouse-clicking on the handle of an object. A contextual 
menu will be displayed where you can select various items.

Smart Shape handles

Menu item What it does

Edit Displays editing handles on selected smart shape

Delete Removes selected smart shape

Align Horizontally (Available for measure- attached Smart Shapes, such as Hairpins, 
Dash, Solid, & Custom Lines, Trills, 8vas, 15mas, Brackets) 
Aligns selected shapes along a horizontal line; for multiple staves, 
aligns selected shapes along a horizontal line at the same distance 
from the staff

Align Vertically (Available for measure- attached Smart Shapes, such as Hairpins, 
Dash, Solid, & Custom Lines, Trills, 8vas, 15mas, Brackets) 
Aligns selected shapes’ end points along vertical lines by resizing 
the shapes

Make Horizontal Over System Break (Slurs, Hairpins, Brackets, Dash, Solid, & Custom Lines, 
Glissandos, Bends and Tab Slides) Smart Shapes over system 
breaks will be horizontal

Maintain Angle Over System Break (Slurs, Hairpins, Brackets, Dash, Solid, & Custom Lines, 
Glissandos, Bends and Tab Slides) Smart Shapes over system 
breaks will maintain angle (not horizontal)

Make Horizontal (Hairpins, Dashed, Solid, & Custom Lines, and Brackets) Snaps 
shape into straight horizontal placement This menu item mirrors 
by default the Horizontal setting in the SMART LINE STYLE DIALOG 
BOX.

Remove Manual Slur Adjustments (Slurs only) Slur will return to default values for placement and 
shape. Frozen engraver slurs will revert to engraver slur behavior. 
See also MASS MOVER MENU.

Engraver Slurs (Slurs only) Choose from Automatic, On or Off. Automatic sets the 
slur to use whatever choice is selected is the Smart Slur Options 
dialog box. On sets the slur to always use an Engraver Slur. Off 
sets the slur to never use an Engraver Slur.

Avoid Accidentals (Slurs only) Choose from Automatic, On or Off. Automatic sets the 
slur to use whatever choice is selected in the Smart Slur Options 
dialog box. On sets the slur to always Avoid Accidentals when 
Engraver Slurs are used. Off sets the slur to never Avoid 
Accidentals.

Direction (Slurs and Bends) Choose from Flip, Automatic, Over and Under. 
Determines the direction of the slur. See SMARTSHAPE MENU.
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Smart Shape Palette
How to get there

Click the Smart Shape Tool W. Choose Smart Shape Palette from the Window Menu, if it isn’t 

already selected.

What it does
This resizable, movable, reshapable, dockable palette contains icons representing slurs, crescendo 
hairpins, brackets, dashed and solid lines, and other intelligent, self-stretching Smart Shapes.

Finale automatically determines the direction of measure-based Smart Shapes (though you can 
override the direction if you choose) by whether the cursor is above or below the middle staff line.

• [Control-menu box]. Double-click this white square to hide the palette. (Choosing Smart 
Shape Palette from the Window Menu– so that the check mark disappears serves the same pur-
pose.)

• [Title bar]. Drag this strip – at the top or left side of the palette–to move the palette.

• [Sizable frame]. This border functions like any sizable frame in a Windows program. Drag 
the sizable frame to resize the palette so that fewer tools icons appear, or to reshape the pal-
ette. This frame can only be resized when floating, not docked.

• Slur Tool • Dashed Curve Tool. Select these tools to create slurs and dashed slurs, respec-
tively.

• Decrescendo Tool • Crescendo Tool. Select these tools to create crescendos and decrescen-
dos that move and break with your score.

• Trill • Trill Extension Tool. Click one of these tools (with or without the Ÿ), then position the 
cursor in the measure where you want the trill extension to begin. Double-click the mouse, 
holding down the button on the second click; drag to the right until the trill extension is the 
desired length.

• 8va •15ma Tool. Click one of these tools, then double-click and drag above a staff to enter an 
one octave up (8va) or two octaves up (15ma) marking in the score; double-click and drag 
below a staff to enter an one octave down (8vb) or two octaves down (15mb) marking. Select 
Smart Shape Options from the Smart Shape Menu to set the font and size for the symbols (for 
example, if you prefer using 8va and 15ma below the staff as well), and choose whether sym-
bols or numbers are used.

• Double-Ended Bracket Tool • Dashed Double-Ended Bracket Tool • Single-Ended 
Bracket Tool • Dashed Single-Ended Bracket Tool • Line Tool • Dashed Line Tool. Click 
one of these tools, then double-click and drag to enter the smart shape in your score. When a 



 

Smart Shape Menu 21-4      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter

                                                                                             
T

T

I

N
C

N
C

P
C

P
C

bracket is placed under a staff, the ends of the bracket will point up. If the bracket is placed 
over the staff, the ends of the bracket will point down. If you selected the Dashed Double-
Ended Bracket Tool or the Dashed Single-Ended Bracket Tool, then the horizontal line will be 
dashed instead of solid.

• Glissando Tool. Click this tool, then double-click and drag to create an angled glissando, or 
double-click a note to attach the glissando to that note and the next. Use Smart Shape Options 
to edit the type of glissando and text used. See SMART SHAPE OPTIONS DIALOG BOX.

• Bend Tool. Click this tool, then click and drag or double-click on the first note to create a 
bend between notes or double-click a note to attach the bend to that note and the next. (These 
are actually just a special case slur.)

• Slide Tool. Click this tool, then click and drag or double-click on the first note to create a slide 
between notes or double-click a note to attach the slide to that notehead and the next.

• Custom Line Tool. Ctrl-click this tool to select, edit or create a user-defined smart shape. See 
SMART LINE STYLE SELECTION DIALOG BOX and SMART LINE STYLE DIALOG BOX for more 
details.

Smart Shape Menu
How to get there

Click the Smart Shape Tool W.

What it does
The Smart Shape Menu gives you control over the appearance and placement of slurs and smart 

shape lines, as well as control over how elements will appear in the score (such as √). For a 
detailed description of how to manipulate each smart shape element see SLUR CONTOUR DIALOG 
BOX, SMART SHAPE PLACEMENT DIALOG BOX, SMART SHAPE OPTIONS DIALOG BOX, and SMART 
SLUR OPTIONS DIALOG BOX.

• Slur Contour. Settings in the Slur Contour dialog box specify the default height and inset per-
centage slurs. See SLUR CONTOUR DIALOG BOX.
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• Smart Shape Placement. When you create a note-attached Smart Shape, its end points snap 
to a certain distance away from the notes to which it is attached. The settings in the Smart 
Shape Placement dialog box specify the default distance between the Smart Shape end points 
and the attached notes. These settings apply to the end points of Smart Shapes you are about to 
create, and Smart Shapes whose end points have not been manually adjusted. See SMART 
SHAPE PLACEMENT DIALOG BOX.

• Smart Shape Options. This dialog box allows you to set various parameters regarding Smart 
Shapes. You can select the character, font, size and style for a number elements. You can select 
the default line style to use for glissandos, slides, and custom lines as well as many other set-
tings. See SMART SHAPE OPTIONS DIALOG BOX.

• Smart Slur Options. This dialog box allows you to set various parameters regarding slurs. 
You can select whether to use Engraver slurs, which avoid collisions with notes and some 
articulations. You can also specify how much distance to allow between slurs and other items, 
how much slope to allow and other settings. See SMART SLUR OPTIONS DIALOG BOX.

• Attach to Measures • Attach to Notes • Attach to Noteheads. Use these commands to tell 
Finale whether to attach Smart Shapes to notes or to measures. When Attach to Notes is 
checked, Finale creates note-attached Smart Shapes when you enter a Smart Shape, automati-
cally drawing and placing it the way you want, according to the settings in the Smart Shape 
Placement dialog box. If Attach to Measures is checked, Finale creates measure-based Smart 
Shapes instead. Choose Attach to Noteheads for slides. Choose Attach to Notes, Measures or 
Noteheads to determine where the next Smart Shape you create will be attached. Note that 
some Smart Shapes are limited to particular attachment styles. For these tools, the other 
Attach options will be greyed out.

• Direction: Flip • Automatic • Over • Under. Finale makes intelligent decisions about slur or 
bend direction, based on whether the attached notes are above or below the middle staff line. 
When you transpose music or change the key, slur directions are automatically changed, with-
out requiring any action on your part. However, there will be times when you’ll probably want 
to change the direction of individual slurs or bends that are attached to notes. This you can 
easily do using the Direction submenu.

The Direction submenu offers you four choices: flip the currently selected slur or bend, place 
a selected slur or bend over the entries; place the slur or bend under the entries; or use auto-
matic placement. Automatic placement uses the rules as shown in the Smart Shape Placement 
dialog box. Over and Under ignore the rules for direction, but still use the attachment values 
that you set in the Smart Shape Placement dialog box. Flip and Automatic have keyboard 
shortcuts of ctrl-F and ctrl-shift-F respectively.

Tip: you can set the default direction for all note-attached slurs by selecting the Direction 
menu item with no slurs or bends selected.
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These options for direction only apply to note-attached slurs or bends (when Attach to Notes 
is checked in the Smart Shape Menu). When Attach to Notes is unchecked and you’re creating 
measure-based slurs or bends, Finale automatically senses their direction based on whether 
you add the slur above or below the middle line of the staff. Press ctrl when you’re creating a 
measure-based slur or bend if you want the slur or bend to go in the opposite direction. To 
change an existing slur or bend’s direction, select the slur or bend and drag the middle editing 
handle up or down to change its direction.

To summarize which settings affect which Smart Shapes:

IMPORTANT for older Finale documents: All files created in Finale 3.2 or older and opened in later 
versions will retain the measure-attachment of the existing slurs and any editing that you did. If 
you want the convenience of note-attached slurs for any of these slurs as well, simply delete the 
old slur and recreate it in the current version of Finale.

All files created in Finale 3.5 to Finale 2001 will have Engraver slurs turned off by default when 
opened in later versions of Finale. If you want the beauty of Engraver slurs, click on the Smart 
Shape Menu, choose Smart Slur Options. In the Smart Slur Options dialog box, check Use 
Engraver Slurs. For more information, see SMART SLUR OPTIONS DIALOG BOX.

Slur Contour dialog box
How to get there

Click the Smart Shape Tool W. Choose Slur Contour from the Smart Shape Menu.

What it does
Use the Slur Contour dialog box to define the general shape Finale will automatically give to all 
slurs without manual edits. Slurs already in the score with manual edits aren’t affected by chang-
ing Slur Contour settings. If you want to change the look of individual slurs that are already in the 
score, use the Smart Shape Tool to make your adjustments (see “SLURS –To move, reshape, or 
delete a note-attached slur”).

In general, slurs have varying heights, depending on the length of the slur. Settings in the Slur 
Contour dialog box specify a flexible range of heights that Finale automatically applies as you 
create a slur. With this feature, most of the slurs you create will require no extra editing. Of course 
you still have the ability to edit each slur individually for those circumstances that require special 
consideration.

Setting Affects

Slur Contour Current slurs and future slurs without manual edits.

Smart Shape Placement Slurs, bends, and glissandos you’re about to create, plus slurs, bends, and glissandos with end 
points that haven’t been manually adjusted.

Slur Thickness  Slurs and bends you’re about to create, plus all existing slurs and bends.

Slur System Breaks Slurs and bends you’re about to create, plus start and end points (across staves) that haven’t been 
manually adjusted in existing slurs and bends.

Smart Slur Options All slurs, both current and future.
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Slur height settings are arranged according to slur length — short, medium, long and extra long:

As you create a slur, Finale senses the length of the slur and automatically applies an appropriate 
height from among these settings.

When the length of the slur falls somewhere between short and medium, or between medium and 
long, Finale finds a proportional height somewhere between the respective settings.
When the slur’s length is less than the short or greater than the extra long slur lengths, Finale sim-
ply applies the height from the short or extra long setting, respectively.
The Slur Contour dialog box focuses on slur height, but you can also set an inset value for each 
slur length to control the amount of “bow” or “hook” at the ends of the slur. The amount of inset 
you choose for your slurs is a matter of style, and it might even be the same for each of the three 
slur lengths in the Slur Contour dialog box. As you create a slur, Finale determines the inset value 
in the same way it determines the height, sensing the length of the slur and automatically applying 
an appropriate inset based on the settings.
The height and inset values combine to form a control point, which is positioned in relationship to 
the start of the slur. When a slur is drawn, its arc approaches, but does not actually reach, the 
height of the control point. So the visual height of the slur itself is actually somewhat less than the 
height of the control point.

Type Length Finale’s default height setting

Short 1/8th inch or less .049 inch

Medium 1 inch .146 inch

Long 3 inches .25 inch

Extra Long 4 inches or more .25 inch
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• Active display area. This area shows a slur that you can edit. Drag the control point handle 
beside the slur to adjust the default height and inset.

• Staff display area. This display area simply shows the slur in proportion to other elements in 
your score.

• Control Points for: Short Span • Medium Span • Long Span • Extra Long Span. Each slur 
length (short, medium, long and extra long) has its own height and inset values. Choose the 
slur length for which you want to change height and inset settings.

• Height. This is the vertical height of the slur’s arc; see the explanation earlier in this section.

• Inset. Changing the default inset value affects the look of the ends of the slur. The slur ends 
are more rounded when the inset is a low number. They take on a flatter look when the inset is 
a high number. The inset is a percentage of the length of the slur.

• Units: EVPUs • Inches • Centimeters • Points • Picas • Spaces. The first time you enter the 
Slur Contour dialog box, the measurement drop-down list defaults to the current unit selected 
in the Measurement Units submenu of the Options Menu. Choose an alternate measurement 
unit if you prefer to work in other units.

• Reset • OK • Cancel. Click Reset to restore the built-in Finale default settings. Click Cancel 
to cancel any changes you made to the settings, or click OK to save any new settings and 
return to the score.
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IMPORTANT: Remember that whenever you create a slur, Finale uses the current Slur Contour set-
tings. However, the settings are never applied to existing slurs.

Smart Shape Placement dialog box
How to get there

Click the Smart Shape Tool W. Choose Smart Shape Placement from the Smart Shape Menu.

What it does and how it works
Settings in the Smart Shape Placement dialog box let you control with precision how slurs, bends 
and glissandos attach to notes or noteheads in a score, by defining their position relative to the top 
center or bottom center of a note or the tip of a stem. This guarantees exact positioning and con-
sistent placement by Finale that would be time-consuming and difficult to achieve if you had to 
manually adjust each Smart Shapes yourself. Any changes you make to a particular type of Smart 
Shapes in the Smart Shape Placement dialog box will affect the corresponding end points of simi-
lar Smart Shapes in the score, except for any end points that have been manually adjusted.

The horizontal and vertical positions of a slur or bend end are measured from a reference point 
that is different for slurs attached to noteheads and those attached to stems.

For slurs or bends attached to noteheads, the reference point is the top center or bottom center of 
the notehead. When the horizontal and vertical offsets are zero, the slur or bend end will touch the 
reference point on the notehead as illustrated below.

For slurs or bends attached to stems, the reference point is the end of the stem. When the horizon-
tal and vertical offsets are zero, the slur or bend end will touch the end of the stem.

IMPORTANT: Remember that whenever you create a slur, bend, slide or glissando, Finale uses the 
current Smart Shape Placement settings. Changes to these settings also apply to corresponding 
end points that haven’t been manually adjusted in existing Smart Shapes. However, end points 
that you’ve manually adjusted are never affected by Smart Shape Placement settings.

˙ ˙

˙ ˙

j
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• Slur • Tab Slide • Glissando. Select the type of Smart Shape you would like to set placement 
options for from the drop-down list. The appropriate list box is displayed for each type.

• Slur List box. The different notational contexts upon which the attachment of slurs and bends 
is based are modeled in the list box. The general placement of slurs and bends is based upon 
standard music notational practice. However, the precise placement is entirely up to you.
Finale makes intelligent decisions about a slur or bend’s direction and end position based on 
the stem positions of notes, as well as conditions of voicing and beaming. The slurs in the list 
box represent the rules that Finale automatically follows. 

Although there are a limited number of examples in the list box, they cover most of the con-
texts for controlling how note-attached slurs will connect to noteheads and/or stems. In the 
first slur model shown in the list box above, you have control over two separate connections, 
even though they appear in the same example.

•The start of a slur or bend where a normal stem-down note begins a slur or bend (i.e., 
the stem is not frozen downward), and

•The end of a slur or bend where a normal stem-down note ends a slur or bend.

The examples shown in the list box are meant to be general; the above example controls all 
similar situations of normal stem-down notes, not merely notes that begin and end on the same 
pitch.
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When you want to change how slurs and bends are attached in specific contexts, select the spe-
cific model and edit its Start Point and End Point. You can edit the settings by dragging the 
slur ends in the display area (or by typing new values in the text boxes).

IMPORTANT: These changes are global. In other words, changes to the Slur Placement settings 
affect all the existing and yet-to-be-entered slurs and bends in your score, unless you’ve man-
ually adjusted the end points of a particular slur or bend; Finale won’t change any slur or bend 
you've deliberately edited. Note that any settings that refer to up-stem or down-stem layers 
also apply to Voice 1 and Voice 2 notes, as well as stems frozen using the Mass Mover, Special 
Tools or Speedy Entry tools.

The list box slur models (contexts) are shown below, with an explanation of how each slur 
connects to its start and end notes (Remember that since bends are just a special case of a slur, 
they are affected by these settings as well):

 

Starting Connection  Context       Ending Connection

Over notehead.
Applies to a down-stem note at the 
beginning of a down-stem or mixed 
stem context.

Down-Stem Notes

Over notehead.
Applies to a down-stem note at the end of a 
down-stem or mixed stem context.

Under notehead.
Applies to a note at the beginning of an 
up-stem context.

Up-Stem Notes

Under notehead.
Applies to a note at the end of an upstem 
context.

Over stem.
Applies to an up-stem note at the 
beginning of a mixed stem context.

Mixed Stem Notes

Over stem.
Applies to an up-stem note at the end of a 
mixed-stem context.

Over stem.
Applies to a note at the beginning of an 
up-stem layer context.

Up-Stem Layer

Over stem.
Applies to a note at the end of an up-stem 
layer context.

Under stem.
Applies to a note at the beginning of a 
down-stem layer context.

Down-Stem Layer

Under stem.
Applies to a note at the end of a down-stem 
layer context.
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Over flagged stem.
Applies to a flagged stem at the begin-
ning of a mixed-stem context.

Mixed-Stem Notes With 
Flag

Can’t be set for this style.
(Uses the connection from the over mixed-
stem notes context.)

Over flagged stem.
Applies to a flagged stem at the begin-
ning of an up-stem layer context.

Up-Stem Layer With Flag

Can’t be set for this style.
(Uses the connection from the up-stem layer 
context.)

Under flagged stem.
Applies to a flagged stem at the begin-
ning of a down-stem layer context.

Down-Stem Layer With Flag

Can’t be set for this style.
(Uses the connection from the down-stem 
layer context.)

Over stem.
Applies to an up-stem note in a beamed 
group, unless it’s the last note in the 
group (so it’s treated as a stemmed 
note). Context may be mixed-stems or 
an up-stem layer

Over Beams

Over stem.
Applies to an up-stem note in a beamed 
group, unless it’s the first note in the group. 
Context may be mixed-stem or an up-stem 
layer.

Under stem.
Applies to a down-stem note in a 
beamed group, unless it’s the last note 
in the group (so it’s treated as a 
stemmed note). Context is a down-stem 
layer.

Under Beams

Under stem.
Applies to a down-stem note in a beamed 
group, unless it’s the first note in the group. 
Context is a down-stem layer.

Under notehead.
Applies to an up-stem grace note that 
precedes a down-stem principal note.

Mixed-Stem Grace Note 
(down-stem principal)

Under stem side of notehead.
Applies to a down-stem principal note that 
follows an up-stem grace note.

Starting Connection  Context       Ending Connection
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As you’d expect, there are exceptions to these rules, and these exceptions allow you more flex-
ibility. If you freeze note stems (for example, when you’re working with two layers or voices 
or using Mass Mover), Finale may automatically flip the slur. You can also override individual 
slur or bend directions by using the Direction submenu in the Smart Shape Menu. Collision 
avoidance in Engraver slurs can also override Smart Slur Placement settings.

• Tab Slide List box. The different notational contexts upon which the attachment of tab slides 
is based are modeled in the list box.

Finale makes intelligent decisions about a tab slides’s direction and end position based on the 
positions of notes, as well as the pitch direction. The slides in the list box represent the rules 
that Finale automatically follows.

When you want to change how tab slides are attached in specific contexts, select the model 
from the list box and edit its Start Point and End Point. You can edit the settings by dragging 
the slide ends in the display area (or by typing new values in the text boxes).

IMPORTANT: These changes are global. In other words, changes to the Tab Slide Placement 
settings affect all the existing and yet-to-be-entered slides in your score, unless you’ve manu-
ally adjusted the end points of a particular slide; Finale won’t change any slide you've deliber-
ately edited.

The slide list box models are shown below, with an explanation of how each slide connects to 
its start and end notes:

 

Over stem.
Applies to a grace note in an up-stem 
layer.

Grace Note in Up-Stem 
Layer

Over stem.
Applies to a principal note in an up-stem 
layer.

Under stem.
Applies to a grace note in a down-stem 
layer.

Grace Note in Down-Stem 
Layer

Under stem.
Applies to a principal note in a down-stem 
layer.

Starting Connection  Context       Ending Connection

Notehead on line.
Applies to a note on a line where the 
pitch is increasing to the next note on a 
different staff line.

Different V,  Lines, Increasing 
Pitch 

Notehead on line.
Applies to a note on a line where the 
pitch is increasing from the previous 
note on a different staff line.

Starting Connection  Context       Ending Connection

j

œ œ

œ

J

œ
œ

œ

œ
œ



Smart Shape Placement dialog box 21-14      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Glissando List box. When you want to change how glissandos are attached edit its Start Point 
and End Point. You can edit the settings by dragging the glissando ends in the display area (or 
by typing new values in the text boxes).

Notehead on space.
Applies to a note on a space where the 
pitch is increasing to the next note on a 
different staff space.

Different V, Spaces, Increasing 
Pitch

Notehead on space.
Applies to a note on a space where 
the pitch is increasing from the previ-
ous note on a different staff space.

Notehead on line.
Applies to a note on a line where the 
pitch is decreasing to the next note on a 
different staff line.

Different V, Lines, Decreasing 
Pitch

Notehead on line.
Applies to a note on a line where the 
pitch is decreasing from the previous  
note on a different staff line.

Notehead on space.
Applies to a note on a space where the 
pitch is decreasing to the next note on a 
different staff space.

Different V, Spaces, Decreasing 
Pitch

Notehead on space.
Applies to a note on a space where 
the pitch is decreasing from the pre-
vious note on a different staff space.

Notehead on line.
Applies to a note on a line where the 
pitch is increasing to the next note on 
the same staff line.

Same V, Lines, Increasing Pitch

Notehead on line.
Applies to a note on a line where the 
pitch is increasing from the previous 
note on the same staff line.

Notehead on space.
Applies to a note on a space where the 
pitch is increasing to the next note on 
the same staff space.

Same V, Spaces, Increasing Pitch

Notehead on space.
Applies to a note on a space where 
the pitch is increasing from the previ-
ous note on the same staff space.

Notehead on line.
Applies to a note on a line where the 
pitch is decreasing to the next note on 
the same staff line.

Same V, Lines, Decreasing Pitch

Notehead on line.
Applies to a note on a line where the 
pitch is decreasing from the previous 
note on the same staff line.

Notehead on space.
Applies to a note on a space where the 
pitch is decreasing to the next note on 
the same staff space.

Same V, Spaces, Decreasing Pitch

Notehead on space.
Applies to a note on a space where 
the pitch is decreasing from the pre-
vious note on the same staff space.

Notehead on a space or line.
Applies to a note on a space or line 
where the pitch is the same to the next 
note on the same staff space or line.

Same V, Same Pitch

Notehead on a space or line.
Applies to a note on a space or line 
where the pitch is the same from the 
previous note on the same staff space 
or line.

Starting Connection  Context       Ending Connection

œ
œ

œ
œ

œ
œ

œ œ

œ œ

œ œ

œ œ

œ œ
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IMPORTANT: These changes are global. In other words, changes to the Glissando Placement 
settings affect all the existing and yet-to-be-entered glissandos in your score, unless you’ve 
manually adjusted the end points of a particular glissando; Finale won’t change any glissando 
you've deliberately edited.

• Active display area. Use the Active display area to alter the Smart Shape model selected in 
the list box. Simply drag the Smart Shape’s end points to adjust where they’re placed relative 
to the notehead or stem. Note that the values for the Start and End Points are updated as you 
drag. Changes you make to the Smart Shape’s end points will apply to all Smart Shapes of this 
type that you create. These changes will also apply to end points that haven’t been manually 
adjusted in all similar Smart Shapes in the score.

• Start Point H: • Start Point V: These settings define the horizontal and vertical positions of 
the Smart Shape in relation to its start point. The Smart Shape initially attaches to the note 
stem or to the center top (or bottom) of the notehead, depending on the rule. 
Drag the cursor to the left or right to change the Smart Shape’s horizontal position. As you 
move to the left, the H: text box changes from zero (the initial setting) to a negative number. 
As you drag the cursor to the right, the H: text box becomes a positive number.
To change the vertical distance or angle between the Smart Shape and the note, drag the Smart 
Shape up or down as far as you need. Drag the cursor up or down to change the vertical offset. 
The further you move the Smart Shape up from its initial setting, the positive number in the V: 
text box increases. If you drag the Smart Shape downward, the number becomes negative.

• End Point H: • End Point V: These settings show the horizontal and vertical positions of the 
Smart Shape in relation to its end point. The Smart Shape initially attaches to the note stem or 
to the center top (or bottom) of the notehead, depending on the rule.

Drag the cursor to the left or right to change the Smart Shape’s horizontal position. As you 
move to the left, the H text box changes from zero (the initial setting) to a negative number. As 
you drag the cursor to the right, the H text box becomes a positive number.

To change the vertical distance or angle between the Smart Shape and the note, drag the Smart 
Shape up or down as far as you need. Drag the cursor up or down to change the vertical offset. 
The further you move the Smart Shape up from its initial setting, the positive number in the V: 
text box increases. If you drag the Smart Shape downward, the number becomes negative.

• Units: EVPUs • Inches • Centimeters • Points • Picas. The first time you enter the Smart 
Shape Placement dialog box, the measurement drop-down list defaults to the current unit 
selected in the Measurement Units submenu of the Options Menu. Choose an alternate mea-
surement unit if you prefer to work in other units.

• Reset • Cancel • OK. Click Reset to restore the built-in Finale default settings. Click Cancel 
to cancel any changes you made to the settings, or click OK (or press enter) to save any new 
settings and return to the score.

Smart Shape Options dialog box
How to get there

Click the Smart Shape Tool W. Choose Smart Shape Options from the Smart Shape Menu.



Smart Shape Options dialog box 21-16      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

What it does
If you find yourself adjusting the shape of every new Smart Shape crescendo in the same way—
for example, decreasing the opening of every crescendo mark—you can define a default opening 
width for the crescendo/decrescendo shape using this dialog box. Then, any new Smart Shapes 
you create will have the appearance you specified as soon as they’re created. (You can always 
adjust them after they’re placed in the score, of course.)

You can choose a different character and font for any Smart Shape that uses a symbol from a font. 
Fonts and symbols can be set for Octave Up (8va), Octave Down (8vb), Two Octaves Up (15ma), 
Two Octaves Down (15mb), Trill (tr), Trill Extension (~), glissando and custom line. You can also 
make fine adjustments to the line width for Crescendo and Decrescendo markings, and set the 
exact length of hooks on single and double hooked Smart Shapes.

Note: Any changes you make to the Smart Shape Options settings, except for the opening width of 
Crescendo and Decrescendo markings, affect all existing Smart Shapes in the score.

• Symbols: Octave Up (8va) • Octave Down (8vb) • Two Octaves Up (15ma) • Two Octaves 
Down (15mb) • Trill (tr) • Trill Extension (wavy line ~); Select; Set Font. Choose the Smart 
Shape symbol you want to change from the drop-down list. Click Select to display the Symbol 
Selection dialog box. Select a new symbol, then click Select to return to the Smart Shape 
Options dialog box. Finale will use the new symbols for shapes created with the Smart Shape 
Tool. Click Set Font to display the Font dialog box, where you can choose a different font for 
the currently selected symbol.

Note: The Trill Extension settings affect the wavy line by itself and the wavy line with the “tr” 
marking.
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• Show Octave Symbols as Text. Select this option to use only numbers 8 or 15, instead of 
Maestro’s octave symbols. When selected, Finale displays 8 for the octave up (8va) and octave 
down (8vb) markings, and 15 for the two octaves up (15ma) and two octaves down (15mb) 
markings. The numbers are displayed in the font set for the particular symbol, so if you prefer 
a font other than Maestro, be sure to change it for each octave symbol.

• Smart Line Style: Glissando • Tab Slide • Custom Line; Line Style Number • Select. 
Select the type of Glissando, Tab Slide or Custom Line you would like to use with the palette 
using this drop-down list. The line style selection you’ve made will be displayed in the Line 
Style Number text box next to the drop-down list. To change your selection, or edit or create 
your line styles click Select and the Smart Line Style Selection dialog box will appear. See 
SMART LINE STYLE SELECTION DIALOG BOX.

• Line Thickness. This text box lets you specify how thick you want Smart Shape straight lines 
to be—the lines you draw using any of the straight-line bracket tools, for example. Custom 
lines have their own thickness settings. This setting, as well as the dash settings, apply to all 
Smart Shapes in the document, meaning that the ones you’ve already created will change to 
reflect the new settings (except custom lines).

• Dash Length • Dash Space. These text boxes govern the “dashedness” of dotted (dashed) 
lines. The Dash Length governs the length of each dash, and the Dash Space is the length of 
the gap between dashes, drawn by any of the dashed Smart Shape tools. Custom lines have 
their own dash settings.

• Hook Length. Enter a value in measurement units for the length of hooks on lines with a sin-
gle hook, lines with a hook at both ends, and lines on the octave and two octaves up and down 
shapes. A larger value lengthens the hook and a smaller value shortens it. Custom lines have 
their own hook length settings.

• Crescendo/Decrescendo: Opening Width. In this text box, enter the width, in current mea-
surement units, you want the open end of all new crescendo or decrescendo hairpin shapes to 
have.

• Crescendo/Decrescendo: Line Thickness. Enter a value in measurement units to alter the 
line thickness of all hairpin markings in the score. As the value increases, the lines become 
thicker; as the value decreases, the lines become thinner.

Note: This setting affects line thicknesses of crescendo and decrescendo markings only. Line 
thickness for all other Smart Shape lines in the piece is defined by the other Line Thickness 
setting in this dialog box or in the Smart Line Style dialog box for custom lines.

• Crescendo/Decrescendo: Make Horizontal. Check this box to draw all future hairpins along 
a horizontal line. Uncheck this box to allow hairpins to draw at an angle. You can also use the 
contextual menu to turn horizontal settings on or off on individual hairpins.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, the changes you’ve 
made to the default Smart Shapes. You return to the score.
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Smart Line Style Selection dialog box
How to get there

Click the Smart Shape Tool W. Choose Smart Shape Options from the Smart Shape Menu. 

Click Select next to Smart Line Style. Or, ctrl-click the Custom Line Tool ¿ in the Smart 

Shape palette.

What it does
The Smart Line Style Selection dialog box allows you to select from a number of user-defined 
Lines styles to place in your score.

• Edit. After selecting an existing Smart Line Style by clicking it, click Edit to enter the Smart 
Line Style dialog box. You can change any aspect of the selected Smart Line Style, however, 
keep in mind that when you edit a Smart Line Style, your editing affects every occurrence of it 
in the score. See SMART LINE STYLE DIALOG BOX.
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• Create. Click Create to enter the Smart Line Style dialog box, where you can design a new 
Smart Line Style.

• Duplicate. Click Duplicate to create a copy of the selected Smart Line Style to modify. You 
can select more than one item. Use Shift-click to select an additional item and include all the 
items in between. Use ctrl-click to select only a specific additional item in the list.

• Delete. After selecting an existing Smart Line Style by clicking it, click Delete to remove it 
from the Smart Line Style Selection dialog box. You can select more than one item. Use Shift-
click to select an additional item and include all the items in between. Use Ctrl-click to select 
only a specific additional item in the list.

• Move Up • Move Down. Click these buttons to move the selected item or items up or down in 
the list. You can select more than one item. Use Shift-click to select an additional item and 
include all the items in between. Use ctrl-click to select only a specific additional item in the 
list.

• Cancel. Click Cancel to return to the score without placing a Smart Line Style in the score.
• Select. After clicking the Smart Line Style you want to place in the score, click Select. You 

return to the score, and can then place the Smart Line Style. Instead of using the Select button, 
you can simply double-click the desired Smart Line Style.

Smart Line Style dialog box
How to get there

Click the Smart Shape Tool W. Choose Smart Shape Options from the Smart Shape Menu. 

Click Select next to Smart Line Style. Or, ctrl-click the Custom Line Tool ¿ in the Smart 

Shape palette.

What it does
The Smart Line Style dialog box allows you to create or edit the Smart Line Style you would like 
to use.
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• Line Style: Solid • Dashed • Character. Select the line style to be used for this item.

• Horizontal. Select this option to ensure that the Smart Shape you are defining can only be 
placed horizontally, not diagonally.

• Line Adjustments: Start H • After Text • Cont H • After Text • End H • Before Text • V. 
Use these settings to adjust where you lines start, continue and end, how high above or below 
your click point they appear, and whether the lines start, continue and end before or after any 
starting or ending text.

• Thickness. Use this setting to modify the thickness of the dashed or solid line. This option is 
only available when Solid or Dashed is select from the Line Style drop-down list.

• Dash Length • Space. Use these options to modify the type of dashed line being used. These 
options are only available when Dashed is selected from the Line Style drop-down list.
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• Character • Select • V (EMs)) • Set Font. Set the character and the font for the item. Click 
Set Font to display the Font dialog box where you can select the font type, size and style. Set 
the vertical positioning of the baseline in EMs (these are point size independent units). Click 
Select to select the actual character to use from the specified font. See FONT DIALOG BOX and 
SYMBOL SELECTION DIALOG BOX. These options are only available when Character is selected 
from the Line Style drop-down list.

• End Point Style: Start • End: None • Preset Arrowhead; Select • Custom Arrowhead; 
Select • Hook. Set the starting and ending style of the line using an arrowhead or a hook if 
desired. Specify the hook length in the Hook text box.

• Text: Left Start • Left Continuation • Right End • Center Full • Center Abbr.; Edit • 
Position. Use these items to set up text combinations for the left, right and center of your cus-
tom Smart Shape. Click Edit to display the Text Edit window where you can edit you text. 
Click Position to set the position of the text relative to the selected line style. See EDIT TEXT 
WINDOW and POSITION SMART LINE STYLE TEXT DIALOG BOX.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, the changes you’ve 
made to the custom Smart Shapes. You return to the score.

Preset Arrowhead Selection dialog box
How to get there

Click the Smart Shape Tool W. Choose Smart Shape Options from the Smart Shape Menu. 

Choose Custom Line from the Smart Line Style drop-down list. Click Select, then Create or Edit. 
Click Select next to Preset Arrowhead.

What it does
The Preset Arrowhead Selection dialog box allows you to select from a number of shapes to use 
for your arrowhead.
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• Cancel. Click Cancel to return to the Smart Line Style dialog box without selecting a preset 
arrowhead.

• Select. After clicking the arrowhead you want to use, click Select. You return to the Smart 
Line Style dialog box. Instead of using the Select button, you can simply double-click the 
desired arrowhead.

Custom Arrowhead Selection dialog box
How to get there

Click the Smart Shape Tool W. Choose Smart Shape Options from the Smart Shape Menu. 

Choose Custom Line from the Smart Line Style drop-down list. Click Select, then Create or Edit. 
Click Select next to Custom Arrowhead.

What it does
The Custom Arrowhead Selection dialog box allows you to select from a number of shapes you’ve 
created to use for your arrowhead.
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• Edit. After selecting an arrowhead, click Edit to enter the Shape Designer dialog box. You can 
modify the arrowhead, however, keep in mind that when you edit an arrowhead, your editing 
affects every occurrence of it in the score. See SHAPE DESIGNER.

• Create. Click Create to enter the Shape Designer, where you can design an arrowhead.

• Duplicate. Click Duplicate to create a copy of the selected arrowhead to modify. You can 
select more than one item. Use Shift-click to select an additional item and include all the items 
in between. Use ctrl-click to select only a specific additional item in the list.

• Delete. After selecting an existing arrowhead, click Delete to remove it from the Custom 
Arrowhead Selection dialog box. You can select more than one item. Use Shift-click to select 
an additional item and include all the items in between. Use Ctrl-click to select only a specific 
additional item in the list.

• Move Up • Move Down. Click these buttons to move the selected item or items up or down in 
the list. You can select more than one item. Use Shift-click to select an additional item and 
include all the items in between. Use ctrl-click to select only a specific additional item in the 
list.
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• Cancel. Click Cancel to return to the Smart Line Style dialog box without selecting a preset 
arrowhead.

• Select. After clicking the arrowhead you want to use, click Select. You return to the Smart 
Line Style dialog box. Instead of using the Select button, you can simply double-click the 
desired arrowhead.

Position Smart Line Style Text dialog box
How to get there

Click the Smart Shape Tool W. Choose Smart Shape Options from the Smart Shape Menu. 

Click Select next to Smart Line Style, then Create or Edit. Click Position.

What it does
The Position Smart Line Style Text dialog box allows you to set the position of custom line text 
relative to the line.

• [Positioning window]. Drag the text in the positioning window to set it’s placement.

• Distance from Staff: H • V. Use these text boxes to set the horizontal and vertical position 
from the line.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, the changes you’ve 
made to the custom Smart Shapes. You return to the score.
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Smart Slur Options dialog box
How to get there

Click the Smart Shape Tool W. Choose Smart Slur Options from the Smart Shape Menu.

What it does
The Smart Slur Options dialog box allows you to specify how your slurs will appear in Finale. 
The dialog box gives you access to Engraver slurs, where slurs will avoid collisions with other 
items. You can decide how much to move the Engraver slur to avoid other objects, such as articu-
lations or note stems. Other settings determine the limits of how far the Engraver slurs will distort 
to avoid a collision.

Finale lets you provide placement options for slurs and bends that break over systems, and lets 
you control the thickness of all Smart Shape slurs in your piece. Slur Thickness is the desired 
thickness of the solid slur lines for every slur in your score.

You can specify exactly where slurs and bends will end horizontally on a staff line and at what 
point horizontally they will start on the next staff line within a system break. You can also specify 
slurs’  and bends’ distances from the staff lines. Finale automatically breaks all slurs and bends 
according to the current Slur System Breaks settings.

Note: Any changes you make to the Smart Slur Options settings affect all existing Smart Slurs in 
the score.

• Slur Tips Avoid Staff Lines. Check this box to have the ends of slurs shift to avoid staff lines.

• Units: EVPUs • Inches • Centimeters • Points • Picas • Spaces. Select the measurement unit 
for the values in this dialog box only.
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• Use Engraver Slurs. Check this box to have slurs avoid collisions with other items, such as 
stems, beams and noteheads. If this box is checked, Finale will use the settings below to deter-
mine how Engraver Slurs should reshape to avoid collisions.

Any manual edit to an Engraver slur will make it immune to Engraver slur settings. It will still 
be marked as an Engraver slur in the contextual menu, but will be frozen. When frozen, 
Engraver slurs will no longer reshape to changes in the notes. Remove Manual Adjustments in 
the contextual menu or the Mass Mover Utilities will revert the slur to behaving like an 
Engraver slur or unfreeze the slur.

Note: Engraver slurs make extensive use of font annotation, to determine the size of other 
musical items in collision avoidance. If you are using a music font not supplied by Coda, we 
strongly recommend you annotate the font for improved performance in Engraver slurs. See 
FONT ANNOTATION DIALOG BOX.

• Space Around Objects. Enter a value for how much space Engraver slurs should leave to 
avoid collisions with other objects.

• Maximum Slur Angle In Degrees. Enter a value between 0 and 90 to restrict the angle of a 
slur. Note: settings made in the Slur Contour dialog box will be ignored if this value is small.

• Maximum Lift. Enter a value to restrict the lift of a slur. Engraver slurs use lift to move the 
entire slur to avoid collisions with other objects.

• Slur Symmetry Percentage. Enter a percent value (between 0 and 100) to allow for slur sym-
metry.

• Avoid Accidentals. Check this box to have Engraver slurs take accidentals into account for 
collision avoidance.

• Slur System Breaks: Avoid Staff Lines by at Least. This is the distance (in the current mea-
surement unit) between slurs and bends, and the top or bottom staff line.

• Slur System Breaks: System Start Adjustment • System End Adjustment. These text 
boxes contain the horizontal start and end points (in the current measurement unit) of slurs and 
bends continuing over system breaks. They default to zero. Enter a positive number for the 
System Start Adjustment to move the start point to the right (into the staff system) for slurs 
and bends that continue over a system break. Enter a negative number for the System End 
Adjustment to specify the horizontal distance from the end of a staff system to the end of a 
slur or bend on that system. Distances are in current measurement units.

The System Start and End Adjustments control only the location of the slur or bend ends 
located at the end of one staff and the beginning of the next, not the placement of the very 
beginning and end of the whole slur or bend (see SMART SHAPE PLACEMENT DIALOG BOX).

• Slur Thickness: Left • Right • H• V. The Slur Thickness text boxes contain values for how 
thick you want Finale to draw slurs (in the current measurement unit). Each slur is composed 
of two curves, an inner curve and an outer curve. These settings determine the relationship 
between the curves - how fat the slur is, how fast it tapers and whether one side is thicker than 
the other (for a “hand drawn” look).
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The V setting determines the general thickness of the slur. Equal values give a balanced slur; 
unequal values make it thicker on one end than the other. The H settings can make the slur 
taper more or less quickly: a positive value on the left (mirrored by the opposite value on the 
right) will make it appear to taper more quickly, a negative value less quickly.

• Slur Tip Width. Enter the desired width for the slur tip. Hint: Slur Tip Width for Shape 
Designer Slurs is set in the CURVES DIALOG BOX.

• Reset. Click Reset to restore the settings to the defaults.

• OK • Cancel. Click OK to confirm, or Cancel to discard, the changes you’ve made to the 
default Smart Slurs. You return to the score.

Smart Playback Plug-in
How to get there

Select a region with the Mass Mover Tool l. From the Plug-ins Menu, choose TGTools, then 

Smart Playback.

What it does
The Smart Playback plug-in adds a playback effect to selected musical elements, such as glis-
sandi, hairpins and trills. The plug-in must be run after the items have been added to the score. 
When any of these items changes, you must run the plug-in again. Also, when notes are changed, 
all playback effects, except hairpins, need to be renewed by running the plug-in again.
The Smart Playback plug-in creates playback for the following items:

Note that the Smart Playback plug-in will not create playback effects for tremolos created by 
adjusting beam extensions, such as the Easy Tremolos plug-in.

Musical Element Method of Creating Playback Effect

SmartShape Glissandi Continuous Data Pitch Bend (maximum of one octave)

SmartShape Hairpin Crescendos/Decrescen-
dos

Continuous Data Volume changes

SmartShape Trill Hidden notes added to layer 4

Articulation Trill Hidden notes added to layer 4
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• Glissandi. Check this box to define SmartShape glissandi markings for playback. The plug-in 
adds pitch bends as continuous data. See PITCH WHEEL under the MIDI Tool. For the glissandi 
to playback correctly, the bender range is set to 12. The maximum range of each glissando is 
one octave.

• Number of steps per quarter note. A glissando defined for playback consists of many 
pitches ascending or descending rapidly via continuous data. Enter a value in this box for the 
number of ascending or descending pitches for each quarter note of time.

• Hairpins. Check this box to make SmartShape Crescendos or Decrescendos playback through 
MIDI volume changes. This is a parameter that is completely independent from the key veloc-
ities that are used to play back dynamic markings or accents. When the file is played, both 
these parameters work together to form the actual loudness of a tone. The plug-in adds gradual 
volume changes as Continuous Data. See VOLUME under the MIDI Tool.

• Volume changes per quarter note. Enter the amount of volume to change here. This feature 
will edit the continuous data of the region. It can be adjusted from 1 to 127 (1=softest, 
127=loudest).
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• Set Volume to 64 at beginning of piece. Check this option to set the continuous data for vol-
ume to 64 at the beginning of the piece. Note: this will not change continuous data for volume 
already applied with the MIDI Tool or plug-ins.

• Trills/tremolos/diddles. Check this box to define trills, tremolos or diddles for playback. 
Trills require Smart Shape trill symbols above the notes (Ÿm) or a Ÿ articulation. Trills are 
written out in layer 4 then hidden. See also LAYER OPTIONS.

• Three slashes = unmeasured tremolo. Check this box to treat the three slash subdivision 
articulation as an unmeasured tremolo. The Tremolo speed value entered below determines 
the playback of this trill.

• Trill/unmeasured tremolo speed (per quarter note). Enter the number of repetitions of the 
pitch per quarter note for unmeasured tremolos or trills.

• Start trill after what percentage of duration. Enter a percentage of the note value to delay 
before starting the trill for unmeasured tremolos or trills. Set this value to zero to start the trill 
immediately.

• Trill interval: Diatonic • Semi-tone • Whole Tone. Select Diatonic to trill between the 
entered pitch and the pitch up a diatonic second. Select Semi-tone to trill between the entered 
pitch and a semitone higher. Select Whole Tone to trill between the entered pitch and a whole 
tone higher.

• Play. Click Play to hear the selection.

• Remove these effects from selection. Click Remove to clear the playback effects from the 
selection.

• Apply • Close • About. Click Apply to apply the current commands and leave the dialog box 
available for the next commands. Click Close to return to the score without making any 
changes. Click About for more information on the complete TGTools plug-in collection.

Slurs (and bends)
There are two ways to create a slur in Finale. The quick, easy way is to use a Smart Shape. A 
Smart Shape slur expands and contracts with the music and automatically breaks in two if it strad-
dles a line break. A bend (with regard to Finale behavior) is just a special case of a slur.

If you want to place identical slurs in more than one staff, however, you can place a slur as a mea-
sure expression. 

Note: Slurs and phrase markings technically serve different musical purposes. However, you use 
the same Finale techniques to create both. In this discussion, the term slur refers to both kinds of 
markings.

If there are times that you don’t want to create a note-attached slur, choose Attach to Measures 
from the Smart Shape Menu to create measure-based slurs.

Tip: if you want all note-attached slurs or bends to be over or under, choose the slur direction 
without any slurs or bends selected. This menu action sets the default direction.
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To create a note-attached slur

• Click the Smart Shape Tool W in the Main Tool palette. The Smart Shape Palette and 

Smart Shape Menu appear. Make sure that a checkmark appears next to Attach to Notes in the 
Smart Shape Menu.

• Click on the Slur Tool W in the Smart Shape palette, then position the cursor on the 

slur’s beginning note. 

• Double-click the mouse, holding the mouse button down on the second click. The note 
will be highlighted and a small slur line will appear. Continuing to hold down the button, drag 
the slur to the right until you reach the note marking the end of the attachment. When Finale 
highlights that note, let go of the mouse button. The new note-attached slur appears. 

To create a slur spanning two consecutive notes, just double-click the mouse on the first note. 
Finale places the slur on the adjacent notes.

To move, reshape, or delete Smart Shape slurs

• Click the Smart Shape Tool W. The Smart Shape Palette and the Smart Shape Menu 

appear. A small handle appears on all existing Smart Shapes in the score.

• Click the handle of the slur you want to modify. The slur displays several diamond handles 
and a polygon connecting the handles.

 

• To move the slur or change its arc or its end points, drag the appropriate handle.

You can modify the slur in a few additional ways if you press shift while dragging: shift-drag 
an outer curve diamond handle to limit the direction you reshape the slur to one direction. 
Shift-click an outer curve diamond handle or Bezier control handle and drag it to the right or 
left to reshape the slur and change the “sharpness” of the slur’s inset; dragging away from the 
center of the slur makes the slur “fatter”, and dragging inward makes the slur more “pointed.” 
Shift-click a Bezier control handle and drag it up or down to reshape the arc of the curve.

Drag this handle to 
move the left endpoint.

Drag this handle to move 
the right endpoint.

Drag this primary handle to 
move the entire shape or select it.

Drag this handle to change the arc 
height. Shift-drag this handle to change 
the arc height asymmetrically.

Drag this handle to change the arc and 
inset of the first half of the slur. Ctl-drag 
to change the arc symmetrically.

Drag this handle to change the arc and inset 
of the second half of the slur. Ctl-drag to 
change the arc symmetrically.
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Note: Constrained dragging is temporarily disabled while slurs are edited. If you would like to 
use constrained dragging press the shift key while you are moving the slur. See MOVABLE 
ITEMS DIALOG BOX for more information on the Constrain Dragging option.

• To remove the slur from the score press delete. 

To change a note-attached slur’s direction
• Select the slur whose direction you want to change (for instructions on selecting slurs, refer 

to “To move, reshape, or delete a note-attached slur”).

• From the Smart Shape Menu, choose Direction, then select the direction (Automatic, 
Over, Under) that you want Finale to place this slur. Or, you can use the keyboard shortcut 
ctrl-F to flip the slur.

To define Slur Contour (height and shape) settings for note-attached slurs

• Click the Smart Shape Tool W. The Smart Shape Menu appears.

• Choose Slur Contour from the Smart Shape Menu. The Slur Contour dialog box appears.

• Choose the desired Slur length—short, medium, or long or extra long. A slur appears in 
the Active display area beside a small square handle (the control point handle). The Staff dis-
play area shows the slur in proportion to other elements in your score.

• Drag the control point handle vertically or horizontally to change the slur’s height and 
inset, respectively. If you prefer, you can enter values into the Height and Inset text boxes. 
The height is displayed in the measurement unit you’ve selected. The inset is a percentage of 
the slur length. Click Reset at any time to return the slur to Finale’s built-in settings.

• Click OK (or press enter) when you’re ready to save the new settings and return to the 
score. Or click Cancel to cancel any changes you made to the settings and return to the score.

To define Slur Placement settings for note-attached slurs 

• Click the Smart Shape Tool W. The Smart Shape Menu appears.

• Choose Smart Shape Placement from the Smart Shape Menu. The Smart Shape Placement 
dialog box appears.

• Choose Slur from the Smart Shape type drop down list in the dialog box. 

• Select a slur from the list box. The slur appears in the Active display area.

• Drag the slur end point vertically and horizontally until the slur attaches to the notes the 
way you want it to attach to similar types of notes in the score. Instead of using the mouse, 
you can enter values into the text boxes using the measurement unit you’ve selected.

• Drag the other end-point of the slur to adjust it. 

• Click Reset at any time to return the slur to Finale’s built-in settings. 

• Click OK (or press enter) when you’re ready to save the new settings and return to the 
score. Or click Cancel to cancel any changes you made to the settings and return to the score.
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Note: All slurs of this type that you create from now on will use the Slur Placement settings. 
The settings also apply to slur end points that haven’t been manually adjusted in all similar 
existing slurs.

To define Slur System Break settings

• Click the Smart Shape Tool W. The Smart Shape Menu appears.

• Choose Smart Slur Options from the Smart Shape Menu. The Smart Slur Options dialog 
box appears.

• Enter a number into the Avoid Staff Lines by at Least text box to specify the desired dis-
tance between the slur and the outside staff line closest to the slur. 

• Enter a value into the System Start Adjustment and the System End Adjustment text 
boxes, specifying where the slur should start and end in each of the staff systems 
spanned by the slur. 

• Click OK (or press enter) when you’re ready to save the new settings and return to the 
score. Or click Cancel at any time if you want to restore the original built-in settings and 
return to the score.

Note: All slurs created from now on will use these settings for each system break. These set-
tings also apply to end points of existing slurs (from one staff to the next), if the end point 
hasn’t been manually adjusted.

To define Slur Thickness

• Click the Smart Shape Tool W. The Smart Shape Menu appears.

• Choose Smart Slur Options from the Smart Shape Menu. The Smart Slur Options dialog 
box appears.

• Enter a number (in a measurement unit you’ve selected) into the Slur Thickness text 
boxes to specify the desired line thickness and shape of all slurs. Each slur is composed of 
two curves, an inner curve and an outer curve. These settings determine the relationship 
between the curves - how fat the slur is, how fast it tapers and whether one side is thicker than 
the other (for a “hand drawn” look).

The V setting determines the general thickness of the slur. Equal values give a balanced slur; 
unequal values make it thicker on one end than the other. The H settings can make the slur 
taper more or less quickly: a positive value on the left (mirrored by the opposite value on the 
right) will make it appear to taper more quickly, a negative value less quickly.

• Enter a number (in a measurement unit you’ve selected) into the Slur Tip Width text box 
to specify the desired thickness of the tip of a slur.

• Click OK (or press enter) when you’re ready to save the new settings and return to the 
score. Or click Cancel at any time if you want to restore the original built-in settings and 
return to the score.

Note: All slurs you create from now on will use these settings. Also remember that all slurs 
already in the score will change to reflect these settings.



Slurs (and bends) 21-33      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

To define Engraver slurs
Engraver slurs can avoid collisions with stems, beams, noteheads, articulations, and accidentals. If 
you transpose the music, Engraver slurs will reshape to avoid collisions with the new layout.

• Click the Smart Shape Tool W. The Smart Shape Menu appears.

• Choose Smart Slur Options from the Smart Shape Menu. The Smart Slur Options dialog 
box appears.

• Check the User Engraver Slurs box. The Engraver slur settings become active.

• Make adjustments to the Engraver Slur settings, if desired. See SMART SLUR OPTIONS 
DIALOG BOX for details.

• Click OK (or press enter) when you’re ready to save the new settings and return to the 
score. Or click Cancel at any time if you want to restore the original settings and return to the 
score.

Any manual edit to an Engraver slur will make it immune to Engraver slur settings. It will still 
be marked as an Engraver slur in the contextual menu, but will be frozen. When frozen, 
Engraver slurs will no longer reshape to changes in the notes. Remove Manual Adjustments in 
the contextual menu or the Mass Mover Utilities will revert the slur to behaving like an 
Engraver slur or unfreeze the slur.

To copy Smart Shape slurs
Using the following technique, you can copy Smart Shape slurs from one place in the music to 
another, or from one staff to another. See also SMARTFIND AND PAINT DIALOG BOX.

• Click the Mass Mover Tool l. The Mass Mover Menu appears.

• Choose Copy and Replace, then Copy Entry Items from the Mass Mover Menu. The 
Entry Items dialog box appears.

• Click Slurs (Attached to Notes). Click OK (or press enter). You return to the score.

• Select the region containing the Smart Shapes you want to copy. See SELECTING MUSIC for 
some region-selecting shortcuts.

• Drag the first source measure so that it’s superimposed on the first target measure. If the 
first target measure is not on-screen, scroll until you see it. Then, while pressing ctrl and shift 
simultaneously, click the first target measure. In either case, the Copy Measures dialog box 
appears (unless you’re copying to a target measure directly above or below the source mea-
sure).

• Type the number of times you want the Smart Shapes copied (horizontally). Click OK 
(or press enter). 

To create a Shape Expression slur
While Smart Shape slurs are quick and easy to put into one staff at a time, you may occasionally 
want to create a Shape Expression slur, and place it into the score using the Expression Tool. 
Expression slurs have an advantage over Smart Shapes: they may be placed into many staves 
simultaneously (using Attach to Measure). They have one significant disadvantage: they don’t 
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break in half if they begin in one system and continue on another. See also SMARTFIND AND 
PAINT DIALOG BOX.

If your Maestro Font Default file is in place, or if you’ve loaded a Shape Expression Library, you 
don’t need to draw the slur in the Shape Designer.

It’s important that you place expression slurs into the score with Metatools. If you don’t, you may 
discover that every expression slur in your piece is reshaped when you change the shape of any 
one of them. (Expressions, the Shape Designer, and Metatools are all discussed under the entries 
EXPRESSIONS.)

When you place a slur into the score with an Expression Metatool, it initially appears in every 
staff. If you want to specify a subset of staves in which it’s to appear, shift–double-click the 
shape’s handle. The Measure Attached Expression Assignment dialog box appears, and you can 
click Staff List Select button to specify the staves in which the slur is to appear. Again, see 
EXPRESSIONS.

• Click the Expression Tool y, and press shift with a number or a letter. (You’re in the 

process of programming an Expression Metatool. You’re going to assign the slur to the num-
ber or letter key you just pressed.) The Expression Selection dialog box appears.

• Select Attach to Measure or Attach to Note. 

• Click Shape. If your Maestro Font Default file is in place—or if you’ve loaded a Shape 
Expression Library—a selection of slur shapes appears.

• If you see the slur you want in the palette, double-click it and press enter. Skip ahead to 
the instruction marked by the asterisk (*).

• If you don’t see the slur you want, click as follows: Create; Select; Create. You arrive at 
the Shape Designer, where you can now create the slur shape.

• Click the Slur Tool W. Starting on the small white circle, drag directly to the right (for 

an over-slur) or to the left (for an under-slur). Finale draws a curve based on the direction 
in which you drag.

• To adjust the slur, click the Selection Tool c, click the curve, and drag the three shap-

ing handles. For more control, double-click one of these handles to make the four control 
handles appear; drag the middle control handles to reshape the curve. Drag the outer handles 
to move the endpoints. 

• Choose OK or Select in each dialog box until you return to the score. You return to the 
score. You’ve now successfully programmed a Metatool.

* To place the slur in the score, hold down the number key corresponding to the Metatool 
you programmed and click the measure where you want the slur to begin. The slur 
appears. To place other slurs in the score, repeat this step.To reshape the slur, double-click its 
handle to make the three shaping handles appear. For more control, double-click one of these 
three handles to make the four control-point handles appear, which you can drag to change the 
slur’s shape.

Tip: You might consider programming two Metatools—one for an over-slur and one for an 
under-slur.
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Trills
A trill is often notated with two symbols: the Ÿ indication and a wavy extension line (~) that indi-
cates the length of the trill. Both components of a trill are available as Smart Shapes and Articula-
tions. If you’ve loaded an Articulations library into your file (or if your Maestro Font Default file 
is in place), you don’t have to create the markings anew. See also ENGRAVER FONT “TRILL TO” 
NOTEHEADS and SMART PLAYBACK.

To create a trill or trill extension line (wavy line)

• Click the Smart Shape Tool W. The Smart Shape Palette appears. (If the palette does not 

appear, choose Smart Shape Palette from the Window Menu to place a checkmark by it.)

• Click the Trill Tool : or =. 

• Position the cursor in the measure where you want the trill or wavy line to begin. 

• Double-click the mouse; on the second click, hold the button down and drag to the right 
until the trill or wavy line is the desired length. As long as you hold the button down, you 
can keep moving the end of the trill or wavy line.

To create a small accidental in parenthesis
To let the player know which notes are to be trilled, a small accidental, sometimes in parentheses, 

is often placed next to the Ÿ symbol. (This tells the player to raise or lower the written pitch by a 
half step for the trill.) This symbol, too, is an Articulation; see ARTICULATIONS. See also 
ENGRAVER FONT “TRILL TO” NOTEHEADS.

To define a trill marking for playback (easy method)
These instructions will help you to create an intelligent Ÿ marking (one that’s defined for play-
back). With this method, the notation looks right and its plays back correctly. To automate this 
process, see the plug-in SMART PLAYBACK.

• Enter the notes you wish to see in layer 3 or layer 4. For more information, see TO ENTER 
MULTIPLE VOICES USING LAYERS.

• In layer 1, enter 16th or 32nd notes that represent how you wish the trill to playback.

• Click the Staff Tool s. The Staff Menu appears.

• Click on the trill measure to select it.

• Press B (for Blank Notation - Layer 1). Or click on the Staff Menu, choose Apply Staff Style 
and choose Blank Notation - Layer 1. See STAFF STYLES.

To define a trill marking for playback (Executable Shape method)
There are a few reasons to use the Executable Shape method, such as needing all of the layers.

• Click the Expression Tool y.



Trills 21-36      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Double-click on, above, or below the note to which you want to attach the expression trill 
mark. The Expression Selection dialog box appears. If you’ve already created the intelligent 
trill, double-click it and press enter. The mark appears in the score. Repeat the process with 
the invisible “restrike keys” expression, if you’ve already created it (as described here).

• Click Create. The Text Expression Designer dialog box appears.

• While pressing alt, type 0217 on the numeric keypad. Click Set Font, choose Maestro 24 

point, and click OK. In the Maestro music font, alt+0217 is the Ÿ marking.

• Click Playback Options. The dialog box expands.

• From the Type drop-down list, choose Transposition. Click Execute Shape, then click 

Select. You’re defining the Ÿ mark to affect the pitch (that is, to “transpose” it up or down by a 
half or whole step). In playback, this transposition will follow the contours of a shape you’re 
about to draw.

• Click Create, then Shape ID, then Create. The Shape Designer dialog box appears.

• From the Shape Designer Menu, choose Rulers and Grid. Select Eighth Notes, type “1”, 
and then click OK. From the Show submenu of the Shape Designer Menu, choose Grid. 
Finale displays a grid, in which each imaginary vertical gridline represents an eighth note’s 
duration, and each horizontal gridline represents a half-step change in the effect of your trill 
marking.

• Click the Multiline Tool W. The next step takes you through the creation of a zig-zag line 

that defines the playback contours of your trill. To use the Multiline tool, you drag to create 
the first line segment, click at each subsequent corner, and then double-click to complete the 
shape. To make your shape match the one pictured here, observe the H: and V: numbers as you 
move the cursor, and place your mouse clicks according to the table below. (Of course, you 
can always drag individual control handles, using the Selection Tool, after you’ve drawn the 
shape.)

For best results, magnify the display by choosing 200% from the View drop-down list.

• Draw the shape as shown: 

Action
H: 

value
V: 

value

Start at... 0 1

Drag to... 1 0

Click... 2 1

Double-click... 3 0
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Note that this figure produces a trill that changes the pitch by a half step (1 unit of the V: coor-
dinate) each eighth note (1 unit of the H: coordinate), and lasts for one half note’s duration, 
like this:

The Executable Shape you design for the playback definition of a trill (left) looks like a graph of the 
pitches played during the trill (middle). This Executable Shape’s default trill sounds like the exam-
ple on the right.

In the Executable Shape Designer dialog box, you’ll tailor the speed, duration, and pitch of the 
trill.

• Press enter twice. You arrive at the Executable Shape Designer dialog box.

• Change the speed of the trilling by entering new values in the Time Scale text boxes. At 
1:1 (the default speed ratio), the note changes pitch each eighth note, which will seem very 
slow unless the tempo is very fast. If you change the second number to 2, so that the Time 
Scale is 1:2, the trill will occur on sixteenth notes instead.

In each case, there are two individual up-down “trills” within the trill—in other words, you 
hear a total of four notes. If you want the trill to last longer, you can tell Finale to repeat the 
entire trill by entering the additional number of times it’s to be played in the Repeat Count text 
box. If the trill now lasts a quarter note, you can type 3 into the Repeat Count text box, and the 
trill will last four times as long (that is, it will repeat three extra times). 

Finally, the trill shape you drew is a half-step trill; for a whole-step trill, set the Level Scale to 
2:1. (You can use even higher numbers if you want the trill to span an interval greater than a 
whole step—a minor third, for example.) This table provides some examples of the settings 
and their effects:

&
c

Ÿ

˙
&

œ
œ

œ
œ
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• Choose OK or Select in each dialog box until you reach the score. You return to the score, 

and the Ÿ marking is in place. The marking, however, only controls the pitches occurring dur-
ing the trill. You must now add a second expression that will instruct Finale to re-articulate the 
note each time the pitch changes (so that you’ll be able to hear the pitches change). Otherwise, 
you won’t hear any trill at all.

• Double-click the note again. The Expression Selection dialog box appears.

• Click Create. The trill marking already appears on the note, so this additional expression can 
be completely invisible. Therefore, don’t type anything into the text box.

• Click Playback Options. The dialog box expands.

• From the Type drop-down list, choose Restrike Keys. Select Execute Shape, then click 
Select. The palette of Executable Shapes appears. You should see your original M shape.

• Double-click the trill shape. Choose OK or Select in each dialog box until you reach the 
score. You can now listen to your trill; while pressing the Space bar, click the measure in 
which it occurs.

To edit the playback of either of the two component trill expressions, ctrl-double-click its han-
dle to enter the Text Expression Designer. Click Show Playback Options, then click Select to 
adjust, for example, the Time Scale or Level Scale for the trill.

To move or delete an expression trill marking

• Click the Expression Tool y; click the note to which the trill marking was attached. 

Its handle appears.

• Drag the handle to move the trill marking; select it and press delete to remove it. 

&
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Time        Level        Repeat
scale        Scale        Count

1:1            1:1            0

1:2            1:1            0

1:2            1:1            1

1:4            2:1            1

Playback
Effect
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8va/8vb
If you click below the staff the ◊ marking will be used instead unless you have specified another 

symbol to use. √ markings affect playback.

To create an √ or ¤ marking

• Click the Smart Shape Tool W. The Smart Shape Palette appears.

• Click the 8va or 15va Tool U or >. The ◊  marking usually goes beneath the music 

it affects. To specify that in this Finale document you want the under-bracket √    Tool to cre-

ate an √   marking instead of the default ◊ marking, choose Smart Shape Options from the 

Smart Shape Menu. The Smart Shape Options dialog box appears, in which you can choose 
either marking to appear at the beginning of the bracket.

• Position the cursor in the measure where the marking is to begin so that the cursor 
arrow points to the staff to which you’re attaching it. 

• Double-click; on the second click, hold the button down and drag to the right. Your dou-

ble-click marks the  √ side of the marking; as you drag, you increase the length of the 

dashed-line bracket. Release the mouse when you’ve positioned the right end where you want 
it.

To move or reshape an √ or ¤ marking

If the marking is already selected, it displays diamond editing handles. If not, click the Smart 
Shape Tool. Any Smart Shape created with this tool displays a handle; click the handle of the 
marking you want to modify.

• Drag the right or left diamond editing handles to move the endpoints. Drag the square 

handle to move the marking. Press delete to remove it. If the √ bracket is long enough 

that it straddles one or more system (line) breaks, it will automatically break into two (or 

more) segments; the continuation portions will have an √  in parentheses.

Brackets: Horizontal lines
This entry contains instructions for placing a horizontal line or bracket above a staff, with or with-
out a hook at the end, like this:

&
œ

œ
œ

œ
œ

œ
œ

J

œ œ

J

œ
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To draw a horizontal line

• Click the Smart Shape Tool W. The Smart Shape palette appears. (If it doesn’t, choose 

Smart Shape Palette from the Window Menu.)

• Click the bracket shape you want. There are several types: some are dotted, some solid; 
some have an upward or downward “hook” at the right end. You can also create a custom line 
style with a hook using the Custom Line Tool. See CUSTOM LINES.

• Position the cursor in the measure where you want the bracket to begin so that the cur-
sor arrow points to the staff to which you’re attaching it. This is particularly important 
when you’re working in orchestral scores; if you accidentally attach a Smart Shape to the 
wrong staff, it won’t appear in the correct staff when the parts are extracted.

• Double-click; on the second click, hold the button down and drag to the right until the 
bracket is the correct length. It’s a good idea to press the shift key just before your double-
click and hold it down while you drag; if you do so, Finale will constrain your dragging action 
to a perfectly horizontal plane, so that your bracket is perfectly level. You could also right 
mouse-click the handle of the bracket and choose Make Horizontal from the contextual menu 
after creating the bracket.

To move, reshape, or delete a Smart Shape line
If the line is already selected, it displays diamond editing handles; if so, skip to the last step.

• Click the Smart Shape Tool W. The Smart Shape palette appears.

• Click the handle of the shape you want to modify. The shape displays diamond editing han-
dles.

• Drag the right or left editing handles to change the line’s length. Drag the square handle 
to move the line. Hint: Press shift to constrain your cursor to vertical and horizontal lines.

• Press delete to remove the selected shape. 

Crescendo/Decrescendo
A crescendo may be notated either as a “hairpin” shape or as the word cresc. or crescendo. The 
hairpin can be created with either of two Finale tools, depending on your purpose. If your goal is 
to create a graphic crescendo marking, you can do so quickly and easily with the Crescendo Tool 
(on the Smart Shapes palette). A Smart Shape crescendo has three special advantages: first, it 
expands and contracts automatically to fit the layout of music it affects; second, it automatically 
breaks into two segments if it straddles a system line break. Lastly, you can use the Smart Play-
back Plug-in to quickly add a playback effect to hairpins created with the Crescendo Tool. See 
SMART PLAYBACK.

If you want to affect the playback only, and you don’t need the marking in the score, you can cre-
ate a smooth, effective volume increase using the MIDI Tool. (Of course, you could also combine 
these two quick techniques to create a graphic and playback crescendo.)

If you want a graphic crescendo that also plays back (or the word cresc. that also affects play-
back), you can use the Expression Tool. This last method is the most complex, but also the most 
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flexible. An expression crescendo, for example, is the only one that can appear in more than one 
staff at once. See also SMARTFIND AND PAINT DIALOG BOX.

In all cases, the process for creating crescendo or decrescendo markings is nearly identical.

To create a Smart Shape (graphic) crescendo or decrescendo marking

• Click the Smart Shape Tool W. The Smart Shape palette appears.

• Click the Crescendo Tool Y or Decrescendo Tool Z. 

• Position the cursor in the measure where you want the marking to begin so that the cur-
sor arrow points to the staff to which you’re attaching it. This is particularly important 
when you’re working in orchestral scores; if you accidentally attach a Smart Shape to the 
wrong staff, it won’t appear in the correct staff when the parts are extracted.

• Double-click; on the second click, hold the button down and drag to the right until the 
hairpin is the correct length. It’s a good idea to press the shift key just before your double-
click and hold it down while you drag; if you do so, Finale will constrain your dragging action 
to a perfectly horizontal plane, so that your hairpin marking is symmetrical and level. If you 
wish to add a playback effect to hairpin crescendos, see SMART PLAYBACK.

To move, reshape, or delete a Smart Shape crescendo
If the hairpin is already selected, it displays handles; if so, skip to the last two steps. See also 
ALIGN/MOVE PLUG-IN.

• Click the Smart Shape Tool W. The Smart Shape palette appears.

• Click the handle of the shape you want to modify. The shape displays handles:

• Drag the appropriate handle to change the width, angle, or height of the hairpin. If you 
do any dragging while pressing shift, the mouse will be “constrained” to horizontal or vertical 
movements.

• Press delete to remove the selected shape.

To align multiple Smart Shape hairpins
You can also use the Align/Move Dynamics plug-in to align hairpins with dynamic expressions. 
See ALIGN/MOVE DYNAMICS.

Drag this handle to move 
the endpoint or change 
the angle of the hairpin.

Drag this handle to move the entire shape.

Drag this handle to 
move the endpoint.

Drag this handle to change the 
width of the opening.
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• Click the Smart Shape Tool W. The Smart Shape palette appears.

• Drag-select or shift-click the handles of the hairpins you want to align.
• Right mouse-click on the hairpin you want the hairpins to align to. Select Align Horizon-

tal or Align Vertical from the contextual menu. If you chose Align Horizontal, the hairpins 
will move to line up along a horizontal line, based on the hairpin you clicked on. If you 
selected hairpins on more than one staff, the hairpins will move to the same distance from the 
staff. If you chose Align Vertical, the hairpins will reshape to line up the endpoints vertically.

To change the default opening and thickness of Smart Shape hairpins
Use this procedure to adjust the default opening for any additional hairpin shapes you place into 
the score.
• Choose Smart Shape Options from the Smart Shape Menu. The Smart Shape Options dia-

log box appears.
• In the Crescendo Opening Width text box, enter a new width value. The units are what-

ever you’ve selected using the Measurement Units command (Options Menu). Any new cre-
scendo or decrescendo symbol you create will have an opening of the size you specified.

• Edit the Line Thickness text box, in the Crescendo/Decrescendo section of the Smart 
Shape Options dialog box. This number controls the thickness of the actual straight lines that 
compose the hairpin shape.

To create a playback crescendo or decrescendo with the MIDI Tool

• Click the MIDI Tool p. Select the region whose playback data you want to affect. If 

you want to affect only a few measures on a staff, select them and then double-click the high-
lighted area. The MIDI Tool split-window appears. Drag through the graph region above the 
notes to select all of them, or shift-click (or drag-enclose) individual note handles if you want 
only certain notes to be affected.

• Make sure Key Velocities is selected in the MIDI Tool Menu; then choose Scale from the 
MIDI Tool Menu. The Scale dialog box appears.

• Specify the degree of crescendo or decrescendo by filling in the From and To text boxes. 
There are two buttons at the bottom of this text box: Absolute, and Percent of Original. If 
Absolute is checked, the numbers you enter are MIDI velocity values, which can be from 0 
(silent) to 127 (very loud). If you choose Percent of Original, you type percentage values (for 
example, you might want to create a crescendo that increases from 100% to 150% of the cur-
rent volume). This last option is useful for preserving the existing dynamic balance of the 
music while still achieving a smooth increase in volume.

• Click OK (or press enter). You can also create a MIDI-based playback crescendo by increas-
ing the MIDI Volume controller. Using the MIDI volume controller will affect all staves. See 
VOLUME and CONTINUOUS DATA. To automate this task for hairpin crescendos, see SMART 
PLAYBACK.

To create a Text Expression (such as “cresc.” or “decresc.”)
You can use any text you want in a Text Expression: “crescendo,” “diminuendo,” and so on.

• Click the Expression Tool y. 
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• Click on, above, or below the note or measure to which you want to attach the marking. 
The Expression Selection dialog box appears. If the crescendo or decrescendo marking 
already appears in the list, double-click it and click OK (or press enter). You return to the 
score.

• Click Create. The Text Expression Designer appears.
• Type the text for your Text Expression (Crescendo, Diminuendo, etc.). Click Set Font to 

choose a type style. If you don’t need to define the expression for playback, press enter three 
times. If you do want the mark to affect playback, jump below to the step that states “Click 
Playback Options”. Follow the instructions there until the final step, at which point you can go 
ahead and click OK (instead of Cancel). The mark will appear in the score.

To create a Shape Expression crescendo (graphic and playback) 
This method of creating a crescendo is more flexible, but more complex. It involves placing into 
the score a hairpin symbol that has been defined for playback.
Note: If the Maestro Font Default file was in place when you created the document, you can skip 
these instructions, because it contains predefined hairpin symbols. You can likewise avoid having 
to construct your own hairpins if you load a Shape Expressions Library by choosing Open Library 
from the File Menu. In either case, jump ahead to the subentry, “To place a Shape Expression cre-
scendo into the score.” These instructions show you how to create the symbol from scratch. For a 
more complete description of the Shape Designer, see SHAPE DESIGNER.

• Click the Expression Tool y. 

• Click any measure. The Expression Selection dialog box appears.

• Proceeding through the dialog boxes, click as follows: Shape; Create; Select; Create. 
You’re now in the Shape Designer.

The following instructions give measurements in points (1/72 inch). If you’ve been working in 
different units, choose Rulers and Grid from the Shape Designer Menu and select Points 
(specify gridlines every 18 points). Choose Grid from the Show submenu of the Shape 
Designer Menu, if you wish. Finally, make a selection from the Line Thickness submenu of 
the Shape Designer—“.5 pt”, for example.

• Click the Multiline Tool W. You’re about to draw a hairpin, segment by segment. To use 

the Multiline tool, click, then drag to create the first line segment, click at each subsequent 
corner, and then double-click to complete the shape. To make your shape match the dimen-
sions of the one pictured here, observe the H: and V: numbers as you move the cursor, and 
place your mouse clicks according to the table below. (Of course, you can always drag indi-
vidual points into position, using the Selection Tool, after you’ve drawn the shape.)
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• Draw the shape, as shown: 

• Press enter twice. Now that you’ve created the shape, you can define it for playback. The cre-
scendo will follow an executable shape—in other words, the volume level will change accord-
ing to a contour you draw in the Shape Designer.

This executable shape will look nothing like the Shape Expression (hairpin) that represents it 
in the score. A crescendo represents a steady volume increase over time; therefore, its execut-
able shape is a straight diagonal line slanting upward. The steeper the line, the greater the vol-
ume increase.

• Click Playback Options. The dialog box expands.

• From the Type drop-down list, choose Key Velocity. Key Velocity is the MIDI parameter to 
be affected by this symbol. 

(Technical note: You could also define the shape to affect MIDI Volume, controller number 7; 
choose Controller from the Type drop-down list, then enter 7 in the Controller text box.)

• Select Execute Shape, then click the Select button. Proceeding through the dialog boxes, 
click as follows: Create; Shape ID; Create. You’re again in the Shape Designer, ready to 
“graph” the volume change.

• Choose Rulers and Grid from the Shape Designer Menu, and select Eighth Notes; spec-
ify a gridline every 1 eighth note, and click OK. The grid in the Shape Designer window 
now shows a horizontal grid point for each eighth note’s duration, and a vertical grid point for 
each one-point drop in key velocity (volume). Using these gridlines as a reference, you’ll 
know how long to make your graph: two gridlines for a crescendo that lasts a quarter note; 
eight for one that lasts a whole note; and so on. In this example, you’ll make the crescendo last 
a half note (four gridlines). (For the moment, don’t worry about the horizontal gridlines.)

• Click the Line Tool R. To use the Line Tool, you simply click and drag in the drawing 

area. To make your shape match the one pictured here, observe the H: and V: numbers as you 
move the cursor, and drag according to the table below.

Action
H: 

value
V: 

value

Start at... 124 18

Drag to... 0 0

Double-click... 124 –18
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• Drag to create a line, beginning on the small white circle, as shown: 

(For a decrescendo, the End line value should be –4.)

You’ve just graphed an executable shape—a graph of volume over time.

• Press enter twice. You’re back at the Executable Shape Designer.

The line you drew only crossed four horizontal gridlines—at this point, it would only drop the 
key velocity level by 4 (on a scale of 0 to 127), which you’d barely hear.

Therefore, in the Level Scale text box, you can multiply the effect of that Executable Shape. A 
10:1 Level Scale produces a crescendo that’s ten times as pronounced as what you drew—in 
other words, that same shape would produce a drop of 40 key-velocity points. For more infor-
mation, see EXECUTABLE SHAPE DESIGNER DIALOG BOX.

• Type 10 into the first Level Scale text box. 

• Press enter three more times; at the final dialog box, click Cancel. You don’t want the 
mark to appear in the score just yet.

To place a Shape Expression crescendo into the score
Once you’ve defined the shape (or loaded a Shape Expression Library, or, if you have begun your 
work from the Maestro Font Default file), all you need to do is place it into the score. Remember 
that only one of each shape is currently present in the piece (in the Shape Expression Selection 
dialog box). If you had placed four crescendos into the score and then decided to stretch or 
reshape any one of them, you’d change the shape of all four at once, because you’d actually be 
redefining the shape of the one crescendo marking. 

Sometimes this effect—changing the shape of all occurrences of a shape at once—is desirable. 
Most of the time, however, you’ll want each crescendo to be independently reshapable. Hence, 
these instructions explain how to assign a crescendo to a Metatool (a keyboard shortcut). Each 
time you use a Metatool to place a shape into the score, Finale creates a duplicate of the original 
shape, allowing you to reshape any one without affecting the others. 

To program an expression Metatool

• Click the Expression Tool y. 

• Press shift-1. The Expression Selection dialog box appears. (You can actually assign a shape 
to any of the letter or number keys. For this example, we’ll link a shape to the number 1 key.)

Point
H: 

valu
e

V: 
value

Begin line at 0 0

End line at 4 4
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• Click Shape, and double-click the hairpin shape. You return to the score, having success-
fully preprogrammed the Metatool.

• While pressing the 1 key, click in the score. If this shape is to be a note attached expression, 
you must click above, on, or below a note or rest. If it’s a measure attached expression, you 
can click anywhere on, above, or below a measure, even a blank one. In either case, the shape 
now appears in the score.

To move or delete a crescendo (Text or Shape Expression)
See also ALIGN/MOVE DYNAMICS PLUG-IN.

• Click the Expression Tool y. 

• Click the note or measure to which the expression was attached. Its handle appears. 

• Drag the handle to move the entire shape. Click the handle and press delete to remove it. 
To stretch the shape, double-click the handle, and drag one of the eight bounding han-
dles that appear. To completely reshape the hairpin, double-click it a second time, and drag 
its individual control-point handles.

Dashed lines
There are two ways to produce dashed (dotted) lines of any length in Finale: Smart Shapes and 
Shape Expressions. In general, you should use a Smart Shape. A Smart Shape has three advan-
tages: First, it expands and contracts along with the measures it affects. Second, it will automati-
cally break into separate segments if it straddles a system line break. Third, there are three dashed-
line Smart Shapes—one with a hook on both ends, one with a hook on the right side, and one 
without hooks, plus you can define custom lines as well. You place Smart Shapes into one staff at 
a time; they may be horizontal or diagonal, and you can control the length of the dashes.

If you want a dashed line to appear in many staves at once (such as a dashed barline), you can cre-
ate one in the Shape Designer, where you can also specify the thickness of the line.

To draw a Smart Shape dashed line

• Click the Smart Shape Tool W. The Smart Shape Palette appears.

• Click one of the dashed line tools. There are three predefined dashed-line tools: one with an 
upward hook at the end, one downward, and one with no hook. To create a custom line see 
CUSTOM LINES. (There is also a dashed curve tool.) To change the lengths of the dashes and 
spaces, select Smart Shape Options from the Smart Shape Menu, and change the numbers in 
the Dash Length and Dash Space text boxes. The units are whatever you’ve selected using the 
Measurement Units command (Options Menu).

If you’re creating an √ or ¤ marking, you’ll notice that there are Smart Shape tools spe-

cifically for these indications; click the appropriate tool. See 8VA/8VB for more information.
• Position the cursor in the measure where you want the line to begin so that the cursor 

arrow points to the staff to which you’re attaching it. 
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• Double-click where the Smart Shape should begin; on the second click, hold the button 
down and drag to the right. Your double-click marks the beginning of the line; as you drag, 
you increase the line’s length. Release the mouse button when you’ve positioned the end of 
the line about where you want it.
Hint: To create a perfectly horizontal or vertical line, press shift before you double-click and 
keep it pressed while you drag. This constrains your dragging.

To move, reshape, or delete a Smart Shape dashed line
If the line is already selected, it displays diamond editing handles. If so, skip to the instruction 
marked by the asterisk (*).

• Click the Smart Shape Tool W. The Smart Shape Palette appears.

• Click the handle of the line you want to modify. The line displays diamond editing handles.
* Drag the right or left diamond editing handles to move its endpoints. Drag the square 

handle to move it. Press delete to remove it. 

To create a dashed line in the Shape Designer
These instructions show you how to make a note attached expression (which appears in one staff). 
Note that you could also place the marking into many staves at once.

Important: If you plan to place more than one of these lines into the score, use Expression Meta-
tools. Otherwise, when you reshape one, you’ll reshape all of them. See EXPRESSIONS—To create 
Expression Metatools.

• Click the Expression Tool y; click on, above, or below the note to which you want to 

attach the line. The Expression Selection dialog box appears. If the dashed line shape already 
appears, double-click it and press enter; you return to the score.

• Proceeding through the dialog boxes, click as follows: Shape; Create; Select; Create. 
You’re now in the Shape Designer.

• From the Line Style submenu in the Shape Designer Menu, choose Dashed. A dialog box 
appears, letting you specify the length of the dashes and spaces.

• Enter the length of the dashes in the dotted line (in the Dash Length text box) and the 
length of the gaps between dashes (Spaces). Click OK. These numbers are whatever units 
of measurement you’ve most recently selected using the Rulers and Grid command.

• Choose Line Thickness from the Shape Designer Menu; choose a thickness from the sub-
menu. If the thickness you want isn’t listed, choose Other, and enter whatever value you wish.

• Click the Line Tool R, and draw a line (by dragging) in the drawing area. You can also 

create curves and other kinds of lines; see SHAPE DESIGNER.
• Even when you add additional lines and curves to your shape, the line will continue to 

have the dash lengths and line thickness you’ve specified until you change those variables 
again. 

• Click OK or Select in each dialog box until you return to the score. 

To move, reshape, or delete an expression line

• Click the Expression Tool y. 
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• Click the measure or note to which the line was attached. Its handle appears.
• Drag the handle to move the entire line. Click the handle and press delete to remove it. 

To stretch the line, double-click the handle, and drag one of the bounding handles that 
appear. To change the line’s angle, double-click it a second time, and drag its individual con-
trol-point handles.
Note: If you hold down the shift key while creating the line in the Shape Designer, you are not 
able to change the angle of the line.

Glissandos
A glissando, or gliss, is represented in the score by a diagonal straight or wavy line.

To create a glissando

• Click the Smart Shape Tool W. The Smart Shape Palette appears.

• Click the Glissando Tool µ. Move the cursor until the tiny arrow points to the starting 

note.
• Double-click where you want the glissando to begin; on the second click, hold the button 

down and drag diagonally. Release the mouse when the glissando has the length and angle 
you want. If the Smart Line Style Selection dialog box appears, you may need to create a glis-
sando. Glissandos are predefined in your default file. See CUSTOM LINES for directions.

To create a glissando between two consecutive notes, just double-click the mouse on the first 
note. Finale places the glissando on the adjacent notes.

To move, reshape, or delete a Smart Shape glissando

• Click the Smart Shape Tool W. The Smart Shape Palette appears.

• Click the Glissando’s handle. The shape displays diamond editing handles.
• Drag the left or right diamond editing handles to adjust the length and angle of the glis-

sando. Drag the square handle to move the entire glissando.
• Press delete to remove the selected line. 

To define Glissando Placement settings

• Click the Smart Shape Tool W. The Smart Shape Menu appears.

• Choose Smart Shape Placement from the Smart Shape Menu. The Smart Shape Placement 
dialog box appears.

• Choose Glissando from the Smart Shape type drop down list in the dialog box. 
• Drag the glissando end point vertically and horizontally until the glissando attaches to 

the notes the way you want it to attach to notes in the score. Instead of using the mouse, 
you can enter values into the text boxes using the measurement unit you’ve selected.

• Drag the other end-point of the glissando to adjust it. 
• Click Reset at any time to return the glissando to Finale’s built-in settings. 
• Click OK (or press enter) when you’re ready to save the new settings and return to the 

score. Or click Cancel to cancel any changes you made to the settings and return to the score.
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Note: All glissandos that you create from now on will use the Slur Placement settings. The set-
tings also apply to glissando end points that haven’t been manually adjusted in all existing 
glissandos.

To change which glissando is assigned to the palette icon

• Click the Smart Shape Tool W. 

• Choose Smart Shape Options from the Smart Shape Menu. The Smart Shape Options dia-
log box appears.

• Select Glissando from the Line Style drop-down list. 

• Click Select next to the Line Style drop-down list. The Smart Line Style Selection dialog 
box appears.

• Select the Smart Shape to be used when clicking the Glissando Tool. You can also type the 
number of the Smart Shape into the text box next to the Select button in the Smart Shape 
Options dialog box to change the selection.

• Click OK. 

To create a playback glissando
The best way to create a glissando effect, at least for keyboard sounds, is to actually write out a 
run and define the notes as grace notes; see GRACE NOTES.To automate the task, use the plug-in 
SMART PLAYBACK.

Tab slides
To create a slide

• Click the Smart Shape Tool W. The Smart Shape Palette appears.

• Click the Slide Tool ∫. Move the cursor until the tiny arrow points to the starting note.

• Double-click where you want the slide to begin; on the second click, hold the button 
down and drag diagonally. Release the mouse when the slide has the length and angle you 
want.

To create a slide between two consecutive notes, just double-click the mouse on the first note. 
Finale places the slide on the adjacent notes.

If the Smart Line Style Selection dialog box appears, you may need to create a Tab slide.  See 
CUSTOM LINES for creating Custom Line Smart Shapes.

To define Tab Slide Placement settings

• Click the Smart Shape Tool W. The Smart Shape Menu appears.

• Choose Smart Shape Placement from the Smart Shape Menu. The Smart Shape Placement 
dialog box appears.

• Choose Tab Slide from the Smart Shape type drop down list in the dialog box. 
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• Drag the slide end point vertically and horizontally until the slide attaches to the notes 
the way you want it to attach to notes of that type in the score. Instead of using the mouse, 
you can enter values into the text boxes using the measurement unit you’ve selected.

• Drag the other end-point of the slide to adjust it. 

• Click Reset at any time to return the slide to Finale’s built-in settings. 

• Click OK (or press enter) when you’re ready to save the new settings and return to the 
score. Or click Cancel to cancel any changes you made to the settings and return to the score.

Note: All slides that you create from now on will use the Tab Slide Placement settings. The 
settings also apply to slide end points that haven’t been manually adjusted in all existing 
slides.

To change which slide is assigned to the palette icon

• Click the Smart Shape Tool W. 

• Choose Smart Shape Options from the Smart Shape Menu. The Smart Shape Options dia-
log box appears.

• Select Tab Slide from the Line Style drop-down list. 

• Click Select next to the Line Style drop-down list. The Smart Line Style Selection dialog 
box appears.

• Select the Smart Shape to be used when clicking the Slide Tool. You can also type the num-
ber of the Smart Shape into the text box next to the Select button in the Smart Shape Options 
dialog box to change the selection.

• Click OK. 

Custom lines
To create a custom line

• Click the Smart Shape Tool W. The Smart Shape Palette appears.

• Ctrl-click the Custom Line Tool ¿. The Smart Line Style Selection dialog box appears.

• Click Create. The Smart Line Style dialog box appears.
• Select a Line Style from the Line Style drop-down list. This determines whether your Smart 

Shape will be a character, or a solid or dashed line.
• If you’ve selected line, you can set the thickness, and the dash settings for a dashed line. 

If you’ve selected a character, such as in the case of a glissando, you can change the character, 
font, and set the vertical offset from a baseline.

• Set the line adjustments for the start and end of the line, arrowheads, hooks, or related 
text. See SMART LINE STYLE DIALOG BOX for details.

• Click OK. 
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To place a custom line

• Click the Smart Shape Tool W. The Smart Shape Palette appears.

• Click the Custom Line Tool ¿. 

• Double-click where you want the line to begin; on the second click, hold the button down 
and drag diagonally. Release the mouse when the line has the length and angle you want.

To change which custom line is assigned to the palette icon

• Click the Smart Shape Tool W. 

• Choose Smart Shape Options from the Smart Shape Menu. The Smart Shape Options dia-
log box appears.

• Select Custom Line from the Line Style drop-down list. 

• Click Select next to the Line Style drop-down list. The Smart Line Style Selection dialog 
box appears.

• Select the Smart Shape to be used when clicking the Custom Line Tool. You can also type 
the number of the Smart Shape into the text box next to the Select button in the Smart Shape 
Options dialog box to change the selection.

• Click OK. 
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